In this class, you will learn how to use a camera to store a viewpoint that can be used later for viewing or rendering a scene. You will also learn how to create a walk-through or flyby of a 3D model. We will use animation settings to manipulate the appearance of your animation and a motion path to control the smooth motion of the animation. You can enhance your animation by adding title clips, callouts, captions, and sound using Camtasia®.

Learning Objectives
At the end of this class, you will be able to:

- You will be able to create a camera to define a static 3D view
- You will be able to record a walkthrough or flyby of a 3D model to a movie file
- You will be able create an animation by following a path and control the viewpoint, speed, and quality of the animation.
- You will be able apply Camtasia software to enhance the movie file

About the Speaker
John is a professor at Kankakee Community College. He has 16 years of CAD teaching experience at universities and colleges. His professional experience covers the span of 30 years, including 13 years of expertise in managing all aspects of the CAD function for large organizations with multiple engineering disciplines, and remote offices such as AECOM and STS Consultants. John’s four main areas of specialization include CAD management and education, information technology, training and performance improvement, and industrial technology. His education includes an MS in training and organizational development from Northern Michigan University. The research project for his master’s degree was “AutoCAD® E-Learning Objects for the Adult Learner.” Additionally, he has a BS in industrial technology and applied sciences with a minor in CAD.

jbordeau@kcc.edu
Once you have a 3D design complete, or even while still in the conceptual phase of design, you may want to take a stroll through the model and have a look around. You may also want to strap on some wings and fly over and around the model to see it from above. A **walkthrough animation** shows a scene as a person would view it walking through the scene. Walkthroughs are typically used to show the interior of a building, but can be created for exterior scenes as well. A **flyby animation** is similar to a walkthrough, except that the person is not bound by gravity. In other words, the scene is viewed as a bird flying above would see it. Flybys often show the exterior of a building.

The **3DWALK** command is used to create a walkthrough by recording views as a camera “walks” through the scene. The **3DFLY** command is very similar, but the movement of the camera is not limited to a single Z value. A path can also be drawn and the camera linked to the path. This handout discusses these commands and other methods used to create the animation you need. In addition, this handout discusses creating and using cameras.

**Creating Cameras**

**Cameras** are used in AutoCAD to store a viewpoint and easily recall it later when needed for viewing or rendering the scene. After the camera is established, you can zoom, pan, and orbit as needed and then come back to the camera view. It is not necessary to create a camera before using the **3DWALK**, **3DFLY**, and **ANIPATH** commands (discussed later in this handout) because these commands create their own cameras.

The **CAMERA** command allows you to add a camera to the scene. Note: the Camera panel may not be displayed in the Render tab of the ribbon. You may have to toggle it on. Cameras are normally placed in the plan view of the scene to make it easy for you to pick where you want to “stand” and where you want to “look.” Once the command is selected, you are first prompted to specify the camera location. A camera glyph is placed in the scene at the camera location, **Figure 1**. Next, you must specify the target location. As you move the cursor before picking the target location, a pyramid-shaped field of view indicates what will be seen in the view (if a 3D visual style is current). Once you select the target location, the command remains active for you to select an option:

```
Enter an option [/?/Name/Location/Height/Target/LEns/Clipping/View/eXit]<eXit>:
```

The list, or ?, option allows you to list the cameras in the drawing. Select this option and type an asterisk (*) to show all of the cameras in the drawing. You can also enter a name or part of a name and an asterisk. For example, entering HOUSE* will list all of the cameras whose name begins with HOUSE, such as HOUSE_SW, HOUSE_SE, and HOUSE_PLAN.

**Reference**

Portions of this document are copyrighted by Goodheart-Willcox Company, Inc. and reproduced with permission from the textbook AutoCAD and Its Applications – Advanced 2013.


The Name option allows you to change the name of the camera as you create it. If you do not rename the camera, it is given a default, sequential name, such as Camera1, Camera2, Camera3, and so on. It is always a good idea to provide meaningful names for cameras. Names such as Living Room_SW, Corner, or Hallway_Looking East leave no doubt as to what the camera shows. If you choose not to rename the camera at this point, it can be renamed later using the Properties palette.

The Location option allows you to change the placement of the camera. Enter the option and then specify the new location. You can enter coordinates or pick a location in the drawing.

The Height option allows you to change the vertical location of the camera. Enter the option and then enter the height of the camera. The value you enter is the number of units from the current XY plane. If you are placing the camera in a plan view, this option is used to tilt the view up or down from the current XY plane.

The Target option allows you to change the placement of the camera target. Enter the option and then specify the new location. You can enter coordinates or pick a location in the drawing.

The Lens option allows you to change the focal length of the camera lens. If you change the lens focal length, you are really changing the field of view, or the area of the drawing that the camera covers. The lower the lens focal length, the wider the field of view angle. The focal length is measured in millimeters.

The Clipping option is used to turn the front and back clipping planes on or off. These planes are used to limit what is shown in the camera view. Clipping planes are discussed later in this handout.

The View option is used to change the current view to that shown by the camera. This option has two choices—Yes or No. If you select Yes, the active viewport switches to the camera view and the CAMERA command ends. If you select No, the previous prompt returns.
Once you have made all settings, press [Enter] or select the Exit option to end the command. The view (camera) is listed with the other saved views in the drop-down list in the Views panel on the View tab of the ribbon and in the View Controls flyout of the viewport controls. Selecting the view makes it the current view in the active viewport. The view is also listed under the Model Views branch in the View Manager dialog box. It can be made current by selecting the view, picking the Set Current button, and then picking the OK button.

**PROFESSIONAL BEST PRACTICE TIP**

In addition to the camera name, many other camera properties can be changed in the Properties palette. The camera and target locations can be changed, the lens focal length and field of view can be adjusted, and the clipping planes can be modified. Also, you can change the roll angle, which is the rotation about a line from the camera to the target, and set the camera glyph to plot.

**Camera System Variables**

The CAMERADISPLAY system variable controls the visibility of camera glyphs. When set to 1, which is the default, camera glyphs are displayed. When set to 0, camera glyphs are not displayed. Creating a camera automatically sets the variable to 1. The Show Cameras button in the Camera panel on the Render tab of the ribbon toggles the display of camera glyphs off and on. Remember, this panel may not be displayed by default.

When creating a camera, if you pick the camera and target locations without using object snaps, you may assume that the camera and target are located on the XY plane (Z coordinate of 0) of the current UCS. This may or may not be true. The CAMERAHEIGHT system variable determines the default height of the camera if a Z coordinate is not provided. It is a good idea to set this variable to a typical eye height before placing cameras. There is no corresponding system variable for the target because the target is usually placed by snapping to an object of interest. If X and Y coordinates are entered for the target location, but a Z coordinate is not provided, the Z value is automatically 0. If a camera was previously created in the drawing session and the Height option was used, that height value becomes the default camera height.

**Cameras Tool Palette**

The Cameras tool palette provides a quick way to add a camera, but the default tools do not allow for the options described earlier. The Normal Camera tool creates a camera with a 50 mm focal length. This camera simulates normal human vision. The Wide-angle Camera tool creates a camera with a 35 mm focal length. This type of view is commonly used for scenery or interior views where it is important to show as much as possible with minimal distortion. The Extreme Wide-angle Camera tool creates a camera with a 6 mm focal length. This camera produces a fish-eye view, which is very distorted and mainly useful for special effects.
Changing the Camera View

Once the camera is placed, it is easy to manipulate. If you select a camera, the Camera Preview window is displayed by default. This window shows the view through the camera, Figure 2. The view in the window can be displayed in any of the 3D visual styles or any named visual style. Select the visual style in the drop-down list in the window. If the Display this window when editing a camera check box at the bottom of the window is unchecked, the window is not displayed the next time a camera is selected. The next time the drawing is opened, this setting is restored (checked).

When a camera is selected, grips are displayed. Refer to Figure 1. If you hover the cursor over a grip, a tooltip appears indicating what the grip will alter. Picking the base grip on the camera allows you to reposition the camera in the scene. If the Camera Preview window is open, watch the preview as you move the camera to help guide you. Selecting the grip on the target allows the target to be repositioned. Again, use the preview in the Camera Preview window as a guide. The grip at the midpoint between the camera and target can be used to reposition the camera and target at the same time. If you pick and move one of the arrow grips on the end of the field of view, the lens focal length and field of view are changed.

Camera Clipping Planes

Clipping planes allow you to suppress objects in the foreground or background of your scene. Picture these clipping planes as flat, 2D objects perpendicular to the line of sight that can be moved closer to or farther from the viewer. Only the objects between the front and back clipping planes and within the field of view are seen in the camera view. This is helpful for eliminating walls, roofs, or any other clutter that may take away from the focus of the scene. Also, the back clipping plane must be enabled when applying fog/depth cueing using the Render Environment dialog box. Clipping planes can be set while creating the camera or later using the Properties palette. Clipping planes can be adjusted using grips.

Figure 2. The Camera Preview window is displayed, by default, when a camera is selected.
To set the clipping planes while creating the camera, enter the Clipping option. You are prompted:

Enable front clipping plane? [Yes/No] <No>:

To enable the front clipping plane, enter YES. You are then asked to specify the offset from the target plane. The target plane is described next. Once you enter the offset, or if you answer No, you are prompted:

Enable back clipping plane? [Yes/No] <No>:

To enable the back clipping plane, enter YES and then specify the offset from the target plane.

The target plane is the 2D plane that is perpendicular to the line of sight and passing through the camera’s target point. Offsets for both front and back clipping planes are from this plane. Positive values place the clipping planes between the camera and the target plane. Negative values place the planes on the opposite side of the target plane from the camera. You can place the clipping planes anywhere in the scene from the camera location to infinity. You cannot, however, place the back clipping plane between the front clipping plane and the camera.

The best way to adjust clipping planes is using the Properties palette or grips. Create the camera and then display a plan view of the camera and target (an approximate plan view is okay). Select the camera and open the Properties palette. In the Clipping category, select the Clipping property. In the property drop-down list, select Front on, Back on, or Front and back on to turn on the appropriate clipping plane(s). Notice that the clipping planes are visible in the viewport, Figure 3. Next, enter offset values for the Front plane and Back plane properties as appropriate or use grips to set the locations of the clipping planes. By displaying a plan view of the camera and target, you can see where the clipping planes are located and visualize their effect on the scene. If the Camera Preview window is open, the clipping is displayed in the preview.
Animation Preparation

The tools presented in this handout make it easy to lay out a path, plan camera angles, and record the movement of the camera. The resulting animation can be directly output to a number of movie file types that can be shared with others. However, there are some decisions to make first.

It is important to plan exactly what you want to see in the animation. Think like a movie director and plan the “shots.” Ask these questions:

- What will be visible from each camera angle?
- Is there a background in place?
- Is the lighting appropriate?
- Will a simple walkthrough suffice or will a flyby be necessary?
- How close is the viewer (camera) going to be to the objects in the scene?
The answers to these questions will help determine the modeling detail required. Do not model anything that will not be seen. Also, do not place detailed materials on objects that are not the focus of the animation. Processing the animation may take a long time. Unnecessary detail may bog down the computer. In addition, walkthroughs and flybys must be created in views with perspective, not parallel, projection.

The “visual quality” of the scene has the biggest impact on the time involved in rendering the animation. An animation can be rendered in any visual style or using any render preset that is available in the drawing. It is a natural tendency to render at the highest level to make the animation look the best. However, a computer animation has a playback rate of 30 frames per second (fps). If a single frame (view) takes three minutes to render using the Presentation render preset, how long will it take to render a 30 second animation? An animation 30 seconds in length has 900 frames (30 fps × 30 seconds). If each frame takes three minutes to render, the entire animation will take 2700 minutes, or 45 hours, to render.

Are you willing to wait two or three days for a 30 second movie? How about your boss or your client? There are trade-offs and concessions to be made. Perform test renderings on static views and note the rendering time. Then, decide on the acceptable level of quality versus rendering time and move ahead with it.

**Walking and Flying**

The process for creating a walkthrough or a flyby is the same. First, the command is initiated. Then, the movement is defined and recorded. Finally, the recorded movement is saved to an animation file. Note: the **Animations** panel in the **Render** tab on the ribbon may not be displayed by default.

When using the **3DWALK** and **3DFLY** commands, you can move through the scene using the arrow keys or the [W], [A], [S], and [D] keys on the keyboard to control your movements. Once either command is initiated, a message appears from the **Help** flyout in the **InfoCenter**, if balloon notifications are turned on. If you expand this message, the key movements are explained. See **Figure 4**. To redisplay this message while the command is active, press the [Tab] key.

- **Move forward.** Up arrow or [W].
- **Move left.** Left arrow or [A].
- **Move right.** Right arrow or [D].
- **Back up.** Down arrow or [S].

You can also navigate through the scene using the mouse. Press and hold the left mouse button and then drag the mouse in the active viewport to “steer” through the scene. With the
**3DWALK** command, the camera remains at the same Z value. With the **3DFLY** command, the Z position of the camera can change. The steps for creating a walkthrough or flyby are provided at the end of this section.

**Figure 4.**
This message from the **InfoCenter** shows the keys that can be used to navigate through an animation.

**Position Locator**
When the **3DWALK** or **3DFLY** command is initiated, the **Position Locator** palette appears. See **Figure 5**. The preview in this palette shows a plan view of the scene. The purpose of this window is to provide an overview of the scene, in plan, while you develop the animation. It does not need to be displayed to create an animation and can be closed if it takes up too much space or slows down the rendering.
Position and target indicators appear in the plan view to show the location of the camera and its target. The green triangular shape displays the field of view. The **field of view (FOV)** is the area within the camera’s “vision.” The field of view indicator is only displayed when the target indicator is displayed. By default, the position indicator is red. The target indicator is green by default. These properties can be changed in the **General** category at the bottom of the **Position Locator** palette.

You can reposition the camera and the target in the plan view simply by picking and dragging either indicator. The effect of the change is visible in the active viewport. Moving the position and target indicators closer together reduces the field of view. Picking the field of view lines and dragging moves the position and target indicators at the same time. The Position Z property in the **General** category sets the Z coordinate value for the position indicator. The Target Z property in the **General** category sets the Z coordinate value for the target indicator. The Z coordinate value determines eye level.

![Position Locator palette](image)

In addition to changing the color of the position and target indicators, you can use the properties in the **General** category to modify the display in the **Position Locator** palette. The Position indicator size property determines if both indicators are displayed small, medium, or large. If the Position indicator blink property is set to On, both indicators flash on and off in the preview. The Preview visual style property sets the visual style for the preview. This setting does not affect the current viewport or the animation. The Preview transparency property is set to 50% by default, but can be changed to whatever you want. If the view in the **Position Locator** palette is obscured by something (a roof, perhaps), you may want to set the Preview
visual style property to Hidden and the Preview transparency property to 80% or 90%. This will make the objects under the roof visible. If hardware acceleration is on, then the Preview transparency property is disabled. The **Performance Tuner** tool in the status bar indicates the on/off status of hardware acceleration.

**Walk and Fly Settings**

General settings for walkthroughs and flybys are made in the **Walk and Fly Settings** dialog box. See Figure 6. Open this dialog box by picking the **Walk and Fly Settings** button in the **Animations** panel on the **Render** tab of the ribbon (in the **Walk** flyout). This panel may not be displayed by default. The dialog box can also be displayed by picking the **Walk and Fly…** button in the **3D Modeling** tab of the **Options** dialog box.

The three radio buttons at the top of the dialog box are used to determine when the message shown in Figure 4 is displayed. The check box determines if the **Position Locator** palette is automatically displayed when the **3DWALK** or **3DFLY** command is entered.

The text boxes in the **Current drawing settings** area determine the size of each step and the number of steps per second. The **Walk/fly step size**: setting controls the **STEPSIZE** system variable. This is the number of units that the camera moves in one step. The **Steps per second**: setting controls the **STEPSPERSEC** system variable. This is the number of steps the camera takes each second. Together, these two settings determine how fast the camera moves in the animation.

**PROFESSIONAL BEST PRACTICE TIP**

You will have to experiment with step size and steps per second values to make an animation that is easy to watch. Start with low numbers (for slow movement) and work your way up. Fast movement is disorienting and makes the viewer feel as if something was not seen, or missed. The viewer should be able to watch at a comfortable pace and get a good look at your design.

To get a feel for the proper speed for a walkthrough, pay attention to the next movie or TV show that you watch. When the director wants you to get a good look at the setting for the scene, the camera very slowly pans around the room. To emphasize distance, the camera slowly zooms in to a target object or person.

**Camera Tools**

The expanded **View** panel on the **Home** tab of the ribbon contains some tools for quickly adjusting the camera before starting the animation. See Figure 7. The **Lens length** slider controls how much of the scene is seen by the camera. The **lens length** refers to the focal length of the camera lens. The higher the number, the closer you are to the subject. The range is from about 1 to 100,000; 50 is a good starting point. There are stops on the slider for
standard lens lengths. You can enter a specific value for the lens length or field of view by selecting the text in the slider, typing the value, and pressing [Enter]. The current view must be a camera view for the slider to be enabled.

Below the **Lens length** slider are text boxes for the camera and target positions. These can be used to change the X, Y, and Z coordinates of the camera or target before starting the animation.

Figure 7. Camera tools are located in the expanded **View** panel on the **Home** tab of the ribbon.

**Animation Tools**

The **Animations** panel on the **Render** tab of the ribbon contains the tools for controlling the recording and playback of the animation. See Figure 8. Remember, this panel may not be displayed by default. The **Record Animation** button is used to initiate recording of camera movement. After the 3DWALK or 3DFLY command is activated, pick the button to start recording. Make sure that you are ready to start moving when you pick the button because recording starts as soon as it is picked.

Figure 8. The **Animations** panel on the **Render** tab of the ribbon is where you can record and play back the walkthrough or flyby animation. This panel is not displayed by default.

Picking the **Pause Animation** button temporarily stops recording. This allows you to adjust the view without recording the actions. When you are ready to begin recording again, pick the record button to resume.
Picking the **Play Animation** button stops the recording and opens the **Animation Preview** dialog box, where the animation is played. See **Figure 9**. The controls in this dialog box can be used to rewind, pause, and play the animation. The slider can be dragged to preview part of the animation or move to a specific frame. The visual style can also be set using the drop-down list. If the animation is created using a render preset, the file must be played in Windows Media Player or another media player to view the rendered detail. Render presets are available in the **Animation Settings** dialog box, as discussed in the next section.

**Figure 9.** The animation is played in the **Animation Preview** dialog box.

Picking the **Save Animation** button in the **Animation** panel stops recording and opens the **Save As** dialog box. Name the animation file, navigate to a location, and pick the **Save** button.

**CAUTION**

While the 3D*WALK* or 3D*FLY* command is active and the record button is on, you are creating an animation. If you move the camera in the **Position Locator** palette and start re-recording the animation to correct a problem, but do not first exit the current 3D*WALK* or 3D*FLY* command session, you are adding another segment to the animation you just previewed. To start over, first exit the current command session.

**Animation Settings**

The **Animation Settings** dialog box may contain the most important settings pertaining to walkthroughs and flybys. See **Figure 10**. These animation settings determine how good the animation looks, how long it is going to take to complete, and how big the file will be. The
dialog box is displayed by picking the Animation settings... button in the Save As dialog box displayed when saving an animation.

Figure 10. The Animation Settings dialog box contains important settings pertaining to walkthroughs and flybys.

The Visual style: drop-down list is used to set the shading level in the animation. The name of this drop-down list is a little misleading because visual styles and render presets are available. The higher the shading or rendering level selected in this drop-down list, the longer the rendering time and the bigger the file size. If you have numerous lights casting shadows, detailed materials, and global illumination and final gathering enabled, settle in for a long wait. A simple, straight-ahead walkthrough of 10 or 15 feet can easily result in 300 frames of animation. If each frame takes about five seconds to render, that equals 1500 seconds, or 25 minutes, to create an animation file that is only 10 seconds long.

The Frame rate (FPS): text box sets the number of frames per second for the playback. In other words, this sets the speed of the animation playback. The default is 30 fps, which is a common playback rate for computers.

The Resolution: drop-down list offers standard choices of resolution, from 160 × 120 to 1024 × 768. These are measured in pixels × pixels. Remember, higher resolutions mean longer processing times and larger file sizes.

The Format: drop-down list is used to select the output file type. The file type must be set in this dialog box. It cannot be changed in the Save As dialog box. The choices of output file type are:

•WMV. The standard movie file format for Windows Media Player.
•AVI. Audio-Video Interleaved is the Windows standard for movie files.
•MOV. QuickTime® Movie is the standard file format for Apple® movie files.
•MPG. Moving Picture Experts Group (MPEG) is another very common movie file format.

Depending on the configuration of your computer, you may not have all of these file type options or you may have additional options not listed here.
PROFESSIONAL BEST PRACTICE TIP

Other AutoCAD navigation modes may be used to create a walkthrough or flyby. Any time that you enter constrained, free, or continuous orbit, you can pick the Record Animation button to record the movements. After you activate the 3DWALK or 3DFLY command, right-click and experiment with some of the other options as you record your animation. You can even combine some of these navigation modes with walking or flying. For example, use 3DFLY to zoom into a scene, pause the animation, switch to constrained orbit, restart the recording, and slowly circle around your model. Animation settings are also available in this shortcut menu.

Steps to Create a Walkthrough or Flyby

1. Plan your animation. Determine where you are moving from and to, what you are going to be looking at, and what will be the focal point of the scene.

2. Set up a multiple-viewport configuration of three or four viewports.

3. In one of the viewports, create or restore a named view with the appropriate starting viewpoint. Make sure a background is set up, if desired.

4. Start the 3DWALK or 3DFLY command. Note in the Position Locator palette the camera location, target location, and field of view. Adjust these in the Position Locator palette preview area or the expanded View panel on the ribbon, if necessary.

5. Position your fingers over the navigation keys on the keyboard.

6. Pick the Record Animation button.

7. Practice navigating through the view and then pick the Play Animation button to preview your animation. When you are done practicing, make sure to cancel the command and reposition the camera at the starting point.

8. Pick the Record Animation button to start over.

9. Start navigating through the view. Try to keep the movements as smooth as possible. Any jerks and shakes will be visible in the animation.

10. When you are done, stop moving forward and then pick the stop (Save Animation) button.

11. In the Save As dialog box, pick the Animation Settings... button. In the Animation Settings dialog box, select the desired visual style, frame rate, resolution, and output file format. Pick the OK button to close the Animation Settings dialog box. In the Save As dialog box, name and save the file.
12. The **Creating Video** dialog box is displayed as AutoCAD processes the frames, See Figure 11.

13. When the **Creating Video** dialog box is automatically closed, the animation file is saved and you can view it. Pick the **Play Animation** button and watch the animation in the **Animation Preview** window. You can also locate the file using Windows Explorer. Then, double-click on the file to play the animation in Windows Media Player (or whichever program is associated with the file type).

14. Exit the command. If you are not satisfied with the results and want to try it again, make sure to exit the command before you attempt another walkthrough or flyby.

**Motion Path Animation**

You may have found it difficult to create smooth motion using the keyboard and mouse. Fortunately, AutoCAD provides an easy way to create a nice, smooth animated walkthrough or flyby. This is done using a motion path. A **motion path** is simply a straight or curved path along which the camera, target, or both travel during the animation.

One method of using a motion path is to link the camera and target to a single path. The camera and its line of sight then follow the path as a train follows tracks. See Figure 12.
Another option when using a motion path is to link the camera to a single point in the scene and the target to a path. For example, the target can be set to follow a circle or arc. The camera swivels on the point and “looks at” the path as if it is being rotated on a tripod. See Figure 13.

A third way to use a motion path is to have the camera follow a path, but have the target locked onto a stationary point. This is similar to riding in a vehicle and watching an object of interest on the side of the road. As the vehicle moves, your gaze remains fixed on the object. See Figure 14.
The fourth method of using a motion path is to have both the camera and target follow separate paths. Picture yourself walking into an unfamiliar room. As you walk into the center of the room, your gaze sweeps left and right across the room. In this case, the camera (you) follows a straight-line path and the target (your gaze) follows an arc from one side of the room to the other.

The **ANIPATH** command is used to assign motion paths. The command opens the **Motion Path Animation** dialog box. See **Figure 15**. This dialog box has three main areas: **Camera**, **Target**, and **Animation settings**. These areas are described in detail in the next sections. The steps for creating a motion path animation are provided at the end of this section.
Camera Area
The camera can be linked to a path or a point. To select a path, pick the Path radio button and then pick the “select” button next to the radio buttons. The dialog box is temporarily closed for you to select the path in the drawing. The path may be a line, arc, circle, ellipse, elliptical arc, polyline, 3D polyline, spline, or helix, but it must be drawn before the ANIPATH command is used. Splines are nice for motion paths because they are smooth and have gradual curves. The camera moves from the first point on the path to the last point on the path, so create paths with this in mind.

To select a stationary point, pick the Point radio button. Then, pick the “select” button next to the radio buttons. When the dialog box is hidden, specify the location in the drawing. You can use object snaps or enter coordinates. It may be a good idea to have a point drawn and use object snaps to select the point.

The camera must be linked to either a path or a point. If neither is selected, the command cannot be completed. If you want the camera to remain stationary as the target moves, select the Point radio button and then pick the stationary point in the drawing.

Once a point or path has been selected, it is added to the drop-down list. All named motion paths and selected motion points in the drawing appear in this list. Instead of using the “select” button, you can select the path or point in this drop-down list.

Target Area
The target is the location where the camera points. Like the camera, the target can be linked to a point or a path. To link the target to a path, select the Path radio button. Then, pick the
“select” button and select the path in the drawing. If the camera is linked to a point, the target must be linked to a path. If the camera is set to follow a path, then you actually have three choices for the target. It can be linked to a path, point, or nothing. To link the target to a point, pick the Point radio button. Then, pick the “select” button to select the point in the drawing. The None option, which is selected in the drop-down list, means that the camera will look straight ahead down the path as it moves.

Animation Settings Area
Most of the settings in the Animation Settings area have the same effect as the corresponding settings in the Animation Settings dialog box discussed earlier. However, there are four settings unique to the Motion Path Animation dialog box.

The Number of frames: text box is used to set the total number of frames in the animation. Remember, a computer has a playback rate of 30 fps. Therefore, if the frame rate is set to 30, set the number of frames to 450 to create an animation that is 15 seconds long (30 × 15 = 450).

The value in the Duration (seconds): text box is the total time of the animation. This value is automatically calculated based on the frame rate and number of frames. However, you can enter a duration value. Doing so will automatically change the number of frames based on the frame rate.

By default, the Corner deceleration check box is checked. This slows down the movement of the camera and target as they reach corners and curves on the path. If this is unchecked, the camera and target move at the same speed along the entire path, creating very jerky motion on curves and at corners. It is natural to decelerate on curves.

The Reverse check box simply switches the starting and ending points of the animation. If the camera (or target) travels from the first endpoint to the second endpoint, checking this check box makes the camera (or target) travel from the second endpoint to the first.

 Previewing and Completing the Animation
To preview the animation, pick the Preview… button at the bottom of the Motion Path Animation dialog box. The camera glyph moves along the path in all viewports. If the When previewing show camera preview check box is checked, the Animation Preview window is also displayed and shows the animation.

To finish the animation, pick the OK button in the Motion Path Animation dialog box. The Save As dialog box is displayed. Name the file and specify the location. If you need to change the file type, pick the Animation settings… button to open the Animation Settings dialog box. Change the file type, close the dialog box, and continue with the save.
Steps to Create a Motion Path Animation
1. Plan your animation. Determine where you are moving from and to, what you are going to be looking at, and what will be the focal point of the scene.

2. Draw the paths and points to which the camera and target will be linked. Draw the path in the direction the camera should travel (first point to last point). Do not draw any sharp corners on the paths and make sure that the Z value (height) is correct.

3. Start the ANIPATH command.

4. Pick the camera path or point.

5. Pick the target path or point (or None).

6. Adjust the frames per second, number of frames, and duration to set the length and speed of the animation.

7. Select a visual style, the file format, and the resolution.

8. Preview the animation. Adjust settings, if needed.

9. Save the animation to a file.

Enhancing Your Animation Movie File with Camastia Software
Camtasia Studio helps you quickly create professional quality videos and share them with anyone, on nearly any device - without formal training. More than a simple screen recorder, Camtasia gives you the tools you need to truly customize and edit your AutoCAD animation videos. Camastia can enhance your animations by:

- Editing your animation files by cutting, splicing, and combining clips with the powerful, yet easy to use, video editor
- Import camera video, music, photos, and more to truly enhance your animations.
- Customize your animations with ready-to-use media themes, animated backgrounds, graphics, and callouts.
- Create interactive animations with clickable links, table of contents and search.
- Easily share animation videos that your viewers can watch anywhere, on nearly any device
Purchasing Camastia Software
You can buy Camastia software online for $299.00 USD each.

https://store.techsmith.com/order/camasiastudio.asp

System Base Requirements:
- Microsoft Windows XP SP3, Windows Vista, Windows 7, or Windows 8
- Microsoft DirectX 9 or later version
- Microsoft .NET 4.0 Client Profile (included)
- Dual-Core Processor minimum, Quad-Core Processor or better recommended
- 2 GB RAM minimum, 4GB RAM or greater recommended
- 2 GB of hard-disk space for program installation
- Display dimensions of 1024x768 or greater
- Dedicated Windows-compatible sound card, microphone and speakers recommended

Importing Your Animation Movie File into Camastia
You can import the following file formats into the Library:
- Video files (.camrec, .avi, .mp4, .mpg, .mpeg, .wmv, .mov, .swf)
- Camtasia Studio does not support multiple tracks in a .mov. Camtasia Studio imports one video and one audio track from a .mov file.
- Only .swf files created from Jing or Camtasia Studio can be imported.
- Image files (.bmp, .gif, .jpg, .png)
- Audio files (.wav, .mp3, .wma)
- Zipped Library

1. In Camtasia Studio, choose the Library tab.
2. Select Import media.
3. Select the file(s) to import. Hold <CTRL> to select multiple files.
4. Click Open. The asset appears in the Library.

To add an asset to the video, drag it from the Library onto the timeline or right-click on an asset and select Add to Timeline.

Adding Title Clips
You can use a title clip to add a static clip with a graphic and/or text to as a title or introduction to your animation or between animation clips on the timeline as a chapter heading or at the end of the animation to display credits or resources. Title clips display on the timeline for a default duration of five seconds.
1. Click Add title clip. The title clip is added to the timeline and to the clip bin.
2. Use the Color button to choose the background color.
3. Enter the title clip text and select any text options such as font style, size, placement, and color.
4. Enable Image to use a graphic as the background for the title clip. The size of the graphic should be the same dimension as the video or black bars may appear.

Adding a Callout
Callouts are graphics that appear on top of a animation to draw viewers’ attention to important objects or processes in a animation.

1. In Camtasia Studio’s Editor, click on the Callouts tab. The Callouts task page appears.
2. Position the playhead on the timeline where the callout appears.
3. Click the Add Callout button.
4. Select a callout from the dropdown gallery. The callout appears in the Preview Window.
5. If desired, enter text into the text box. The text is updated to the callout in the Preview Window.
6. Drag the callout to the desired location in the Preview Window.
7. Drag the callout to the desired location in the Preview Window.
8. Grab a handle to adjust the size.
9. If desired, make changes to the Border color and width, Fill color, and other Effects such as shadow, opacity and style.

Adding Narration
Use voice narration to insert a voice recording into the animation video.

- The video clips on the timeline play in the Preview Window while recording voice narration.
- Camtasia Studio synchronizes the voice narration with the clips on the timeline.
- The audio clip created appears on the timeline when the voice narration ends.

Record Voice Narration
You must set up a microphone before you can record voice narration.
1. Arrange the video and complete the necessary edits before recording voice narration.
2. Drag the playhead’s green In point or red Out point to record for a timeline selection. Or:
   To record for a clip, click on the clip to highlight it.
   To record for the entire timeline, do not make any selections.
3. Enable the Mute speakers during recording option when clips on the timeline include audio. The microphone may record audio playing from the speakers.
4. Choose the audio track for this recording when added to the timeline.
5. Select the recording duration.
6. Click the Audio Setup Wizard button to set the audio input options.
7. Click **Start Recording**.
8. Narrate the clip(s) using the playback in the Preview Window as your guide.
9. The recording automatically stops when video reaches the end of the selection, end of the clip, or end of the timeline.
10. Name and save the audio clip. The recording is added to the timeline.

**Adding Captions**
Captions display onscreen text within an animation to provide additional or interpretive information to viewers. Captions are used to create animation videos accessible to a larger audience, such as:

- Viewers with hearing impairments
- Viewers that cannot listen to audio with their current settings
- International audiences with subtitles and onscreen translations for non-native speakers

To add a new caption:
1. Click the **Captions** tab.
2. Position the playhead at the desired location on the timeline.
3. Click **Add caption**. A new caption text box appears.
4. Type or paste text into the text box. The caption appears on the timeline and in the Preview Window as you type.

**Produce and Sharing a .Mp4 file**
Production presets contain production settings optimized for your intended distribution method: Blog, CD, DVD-Ready, HD, iPhone, iPod, Screencast.com, Web, or YouTube.

The Production Wizard automatically selects a preset setting compatible with the dimensions selected in the **Editing Dimensions** dialog box.

To Produce and Share
1. Make all edits to your video.
2. Click **Produce and Share**.
3. The **Production Wizard** appears. A preset based on your editing dimensions is the default. Select the Web option. To choose another preset, make a selection from the dropdown menu.
4. The specific settings for the preset appear.
5. Click **Next**.
6. Enter a name and file location. Click **Next**.
7. Click **Finish**.

The video begins rendering and saves to the selected location.
Reference
Portions of this document are copyrighted by Goodheart-Willcox Company, Inc. and reproduced with permission from the textbook AutoCAD and Its Applications – Advanced 2013.

Professor John R. Bordeau
Kankakee Community College
jbordeau@kcc.edu